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Excel in ME: Packaging Add-ins and Providing Online Help
Abstract
Microsoft Excel is a ubiquitous software tool that provides an excellent electronic format for
engineering computation and organization of information. This paper reports on the second year
of an NSF CCLI Phase I project to implement a sequence of Excel modules for use in the
Thermal Mechanical Engineering Curriculum.
Several modules were developed in the first year of the program including several for Heat
Transfer. These modules have been integrated and significant online help modules developed to
assist the user. Additional integration occurred in the second year of the NSF project with
module development assisting in Energy Systems Design engineering calculations. The method
for developing these modules mimicked the approach used in development of the Heat Transfer
modules. Similar online help was developed for the Energy Systems Design modules. Details of
the help compiler process, which are not widely documented, are described. Example problems
illustrating sound engineering workbook solution techniques and access to the help files are
given.
Introduction
In the mechanical engineering curriculum, consistent organization remains a key to successful
teaching and learning. The mission of presenting students with the most straightforward and
accommodating software learning environment requires great organization and tedious planning.
These organization and support methods must also be readily available to offer optimal “userfriendliness.” Although several Microsoft Excel-based modules for use in the mechanical
engineering curriculum had been developed and made readily-available via download over the
internet, a re-evaluation of the project status determined that a more consistent organization
format was needed. Also, the ability to offer more assistance to the user beyond the user-defined
function descriptions was clearly desired. Through discovery of many of the seemingly
unlimited features in Microsoft Excel, it was determined that the developed macros could be
easily rearranged. Also, internet research proved that a compiled help file could be created and
applied to the Excel-based modules in order to offer more “user-help.” In the interests of
providing maximum classroom time for applying the learned material of the course, the
previously developed Excel-based modules were rearranged and paired with compiled “userhelp” files in turn allowing students to solve more complex problems in the thermal mechanical
engineering curriculum.
Prior status of Modules
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The prior organization of the developed modules resulted from the order in which they were
created and subsequently tested in their “beta” phase. Since module development mostly
occurred in conjunction with the teaching of a course, modules were created as separate entities
for each specific topic in the course. As these modules developed individually, they were then
made available to users enrolled in the courses where they could be evaluated for further
development.

Prior Add-In Status
All developed modules were converted to Microsoft Excel Add-Ins1. The conversion of these
developed modules into Add-Ins from within the Visual Basic (VB) editor requires the editor to
save the Visual Basic code as a .xla (Office 2003) or .xlam (Office 2007) file extension1. With
these files in the Add-In format, they could now be posted on-line and made available for
download by students. A central location for accessing these Add-In files was needed. As a
result, a project website1 was created where each topic specific Add-In was posted on a page for
the corresponding course along with a description of the Add-In’s contents1. Figure 1
demonstrates the original website organization and Add-In tool distribution for the two courses,
Heat Transfer and Energy Systems Design.

Excel in ME Website
Heat Transfer (ME 309) Webpage

Energy Systems Design (ME 415) Webpage

1-D Conduction.xlam
Nusselt.xlam

Radiation.xlam

Fin Efficiency.xlam

Hardy.xlam

Viscous
Pump.xlam
HX EffectivenessNTU.xlam

Figure 1 Original Excel in ME website organization
The Heat Transfer webpage offered the three individual Add-Ins shown above Nusselt.xlam, 1-D
Conduction.xlam, and Radiation.xlam. The Nusselt Add-In contained nine functions for
calculating Nusselt numbers according to the correlations given in the heat transfer text5. The
1-D Conduction Add-In contained six functions for transient heat conduction solutions, and the
Radiation Add-In included five functions important for solving radiation heat transfer problems.
The correlations used for the 1-D Conduction and Radiation Add-Ins were also taken from the
heat transfer text mentioned above.
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The Energy Systems Design webpage offered the four individual Add-Ins Fin Efficiency.xlam,
Hardy.xlam, HX Effectivness-NTU.xlam, and Viscous Pump.xlam all seen above in Figure 1.
The Fin Efficiency Add-In, containing efficiency calculators for six different types of fins, was
developed from a spreadsheet and equations given in the heat transfer5 and energy systems
design7 text. The HX Effectiveness-NTU Add-In included effectiveness-NTU relations for eight
different heat exchanger types and was also developed from both the heat transfer and energy
systems design course books. The Hardy Add-In supplied functions for calculating values of
flow and head loss in piping systems using Hardy-Cross and Darcy-Weisbach relationships given

in the energy systems design course manual referenced above. Finally, the Viscous Pump AddIn provided two different functions for calculating corrected pump curved data for high viscosity
fluids. This Add-In utilized a relationship provided in the energy systems design text.
With this website structure, each new topic covered in the course required users to visit the
on-line site and download the matching Add-In for that problem type. For example, a student
needing to solve a radiation heat transfer problem would have to visit the website in order to
download and install the appropriate Radiation Add In or Radiation.xlam file. This organization
is perhaps beneficial to the casual user not needing help with all topics in a particular course.
However, students in particular can be burdened by managing multiple Add-Ins for each course.
Therefore, it is reasoned that a re-packaging of the modules was needed to promote consistent
use throughout the length of a course.
Prior Help Status
As part of development of the modules for Heat Transfer and Energy Systems Design, several
forms of user help were created. Microsoft Excel offers several ways to incorporate help for the
user of an Add-In. Also, help was created in PowerPoint files to assist the user in Excel
navigation and operation of specific user-defined functions.
Perhaps the simplest way to integrate help into Excel user-defined functions is to type a function
description directly into the Macro Options window. This Macro Options window can be found
on the View tab in Microsoft Excel 2007 and is seen below in Figure 2.

Figure 2 Macro options function description input window
The function descriptions can then be seen the next time the function is used. When a user
employs the Insert Function button in Excel, a window appears showing the function arguments
and supplied description.
Page 14.601.4

The user-defined function descriptions can also be entered or typed into the VB code. This
method allows the developer more freedom to categorize the functions for a specific group. For

example, the group of functions dealing with calculations of Nusselt numbers can have their own
“Category” as seen below in Figure 3.

Nusselt Number
“Category” Heading for
User-Defined Functions

Figure 3 Insert function window with category designation
By utilizing the Macro Options command and inserting the following example character string in
VB, a category will be created according to whatever is placed in the last argument of the
MacroOptions Application.
Application.MacroOptions Macro:="NuBarPlate", Description:="Average
Nusselt number for convection over flat plate. Properties at film
temperature. Re - Reynolds number, Pr - Prandtl number, [Optional Re_xc
- Critical Re for Turbulent flow, default 5e5], [Optional Quiet = TRUE to
suppress warnings]", Category:="Nusselt Number"
Although this particular mode of help is useful, the extensiveness of the help is limited by
several factors. These limitations exist due to the inability to supply schematics, figures, or
equations. Also, each function description is restricted by the letters, numbers, and symbols on
the keyboard as well as a 255 character count.
The help files created in Microsoft PowerPoint were designed to assist the user not only with
specific user-defined functions but also general Excel tips. The PowerPoint tutorials available
for download from the project website include topics in the use of Add-Ins, general Excel tips,
and Energy Systems Design-Heat Transfer functions. Each tutorial includes a description of its
contents below the download link.
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Once all of the descriptions for the user-defined functions were finished, a reevaluation of the
project progress determined that the provided modes of help were still lacking in the extensive
detail and availability that was desired by the research team. A more extensive help would

provide the ability for more informative wording, figures, schematics, and equations. The
discovery of the “Help on this function” link, seen below in Figure 4, served as an impetus for

“Help on this function”
Link for User-Defined
Functions

Figure 4 Function help link
the next step in the research project. More extensive user help was desired. Consequently, a new
level of integration presented itself for study and implementation.
Repackaging Heat Transfer and Energy Systems Design Modules
While a casual user of the Excel in Mechanical Engineering website may find the prior module
organization sufficient, a more frequent visitor might find the organization cumbersome and
possibly discouraging. The aforementioned design is unique in that it allows a user the option to
‘pick and choose’ which Add-Ins he or she desires to have. However, several significant
advantages are realized by combining several modules into one larger Add-In according to their
course designation. The main motivation for repackaging is to maintain one Add-In per course.
So, the Heat Transfer course will have one Add-In. Accordingly, the Energy Systems Design
course will have one Add-In. Therefore, a more user-friendly design becomes available from
within the Excel environment.
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As was mentioned earlier, students in a particular course can become easily burdened by
managing multiple Add-Ins for each course. A more advantageous re-packaging of the modules
would include the combining of all topic material (separate Add-Ins) into one new and bigger
module for each course. This is a more practical layout as opposed to asking the user to
download and install multiple times over the length of the course. While maintaining one AddIn per course was the primary motivation for the repackaging project, several other advantages
are realized from this new organization. First, one single Add-In is not that much bigger in size
compared to having numerous Add-Ins for the same information. One combined Add-In for the
Heat Transfer or Energy Systems Design courses could be somewhere between 60-100 KB.
Second, the Category application mentioned earlier provides a way to group all applicable

functions into one sub-heading such as “Heat Transfer”. Third, only a single download and
install for each computer the user chooses to supply with the Add-In is required. This allows for
and encourages consistent spreadsheet solutions necessary for well-documented electronic
engineering calculations2.
The process for combining several smaller modules into one larger module is fairly simple. This
new organization scheme becomes a matter of creating a new Visual Basic for Application
(VBA) project and combining the VB code from all separate modules. For example, the module
for the Heat Transfer course can be seen below in Figure 5.

Individual modules all
grouped under the
Heat Transfer.xlam
VBA Project

Sample code from
HX_eff_NTU module

Figure 5 Visual Basic Editor for combining into one Add-In
In the Heat Transfer Add-In, the VB code is split into its several different modules as seen on the
left of the screenshot. There are separate modules for the function descriptions, conduction
functions, fin calculators, heat exchanger-effectiveness relationships, Nusselt numbers, and
radiation functions. However, they are all part of the same VBA project and remain as one
single Add-In. On the right of the screenshot is a view of the sample code from the heat
exchanger-effectiveness relationships module. The same method was used for creating the
Energy Systems Design course Add-In. Figure 6 below demonstrates the grouping of the new
course Add-Ins.
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Nusselt.xlam

Heat Transfer.xlam (ME 309)

1-D Conduction.xlam
Radiation.xlam

Excel in ME Website
Fin Efficiency.xlam
HX Effectiveness-NTU.xlam
Hardy.xlam
Viscous Pump.xlam

Energy Systems Design.xlam (ME 415)

Figure 6 New organization of Add-Ins for each course
Previously, the Heat Transfer webpage offered the three individual Add-Ins shown above
Nusselt.xlam, 1-D Conduction.xlam, and Radiation.xlam. During repackaging, a logical
decision was reached that prompted the developers to assign all course material pertinent to heat
transfer in the heat transfer Add-In. Therefore, the contents of the Fin Efficiency.xlam as well as
the HX Effectiveness-NTU.xlam were grouped with the rest of the previously designated Heat
Transfer Add-In. The material that was left over would be assigned to the Energy Systems
Design Add-In. This included only the Hardy.xlam and the Viscous Pump.xlam.
The new Add-Ins are posted on-line and have been made available at the same location for the
project website(www.me.ua.edu/ExcelinME). A view of the Heat Transfer web page can be seen
below in Figure 7.
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Figure 7 Sample screenshot of heat transfer web page
A short course description as well as an explanation of the capabilities of the Heat Transfer AddIn is provided. Also, links to tutorials on the website are provided for assistance in using
Microsoft Excel and in particular using Add-Ins. The combined format of the modules offers a
cleaner and more user-ready environment for Excel-based mechanical engineering calculations.
Microsoft HTML Workshop
After a thorough internet research, a connection was discovered between the “Help on this
function” link in Microsoft Excel and its ability to support Microsoft Compiled HTML Help.
Microsoft HTML Help Workshop is a help authoring toolbox for developing a set of web pages
in subsets of HTML along with hyper-linking capabilities for a table of contents, index, and
keywords4. Microsoft Compiled HTML Help was first released with Windows 98 and is still
supported up through Windows Vista. Most Windows packages come with the HTML Help
Workshop pre-loaded. The most recent version, the HTML Help Workshop 4.74.8702.0 can also
be found on the internet at the Microsoft Developer Network (MSDN) web site4.
One unique characteristic of the HTML help compiler is its ability to compress HTML and
graphics into relatively small compiled help (.chm file extension). These files can then be
distributed with software or downloaded from the internet. Instruction for creating help projects
is hard to locate on the internet and little guidance is offered by Microsoft. To provide assistance
in methods for developing help projects, several screenshots with explanations will help to
solidify the background information needed to create a compiled help file (.chm) from the
developer’s standpoint. Upon running the HTML Help Workshop, the user first has to create a
new project. The home screen appears and can be seen in Figure 8.
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Figure 8 HTML Help Workshop home screen
To begin creating the pieces of a project, the developer first creates a new HTML Help file under
the File tab. The developer is then asked to provide a Title for the HTML file as seen in Figure
9.

Figure 9 Create and name the help file windows
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Once the help file has been created, there are really no limitations as to the extent of detail that
can be supplied. Any HTML code can be supported as well as several options for the developer
to change background colors and the help pop-up window size. Therefore, figures and graphics
can be provided through the use of the HTML Help Image Editor which is installed in
conjunction with the HTML Help Workshop. Any kind of figures can be pasted into the HTML

Help Image Editor. For example, the scanned image in Figure 10 below was opened and saved
as a bitmap (.bmp) so that it can be inserted into the HTML code for a particular help file.

Figure 10 HTML Help Image Editor sample screenshot
Once all the desired information is entered into the HTML help file(.htm extension), it should be
saved. A table of contents (.hhc extension) can be created from the Contents tab in the HTML
Help Workshop. By inserting a page in the Table of Contents entry, the dialog box in Figure 11
will appear.

Figure 11 Table of Contents entry window in HTML Help Workshop
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The Entry title slot provides the option for naming the particular Table of Contents heading that
has been added and therefore linked to the specific user-defined function help file(.htm). This

name will appear again when the compiled help file (.chm) is running in an open window. The
Table of Contents allows for instituting a function hierarchy or organization system with Folders
concerning broad topics, for example Nusselt numbers, and a subset html page for a specific
user-defined function, such as NuBarPlate for calculating averaged Nusselt number over a flat
plate.
The last important piece of the HTML Help Workshop involves creating an Index header file(.h
extension) in order to provide capabilities for linking a particular help file with its corresponding
user-defined function in Excel. Figure 12 shows a simple Index file created in Notepad that
assigns a number value to each particular Excel user-defined function.

Figure 12 Sample index file
The developer ultimately will have to re-visit the VB code in order to assign these number values
to each function as another Macro Option application. Once the steps of creating and saving all
of the help files (.htm), the table of contents file (.hhc), and the index file (.h) are complete, the
developer should then go to the Save all files and compile button on the Project tab within the
HTML workshop. Performing this step will create the compiled help file (.chm) that will be
used to link to the “Help on this function” in Microsoft Excel. These basic screenshots are only
a brief introduction of the many capabilities of the Microsoft HTML Help Workshop.
Writing Help Files for Heat Transfer
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The task of writing help files for each course Add-In can become a considerable undertaking
depending on the depth and detail desired in a help file and the number of user-defined functions

that need additional help beyond the function description. In order to develop the Heat Transfer
compiled help file, a system was devised to help complete the development of nineteen
individual help files (.htm) into one compiled help file (.chm).
Help files for each individual function were written to compliment the function descriptions that
already existed. Care was taken to explain to the best capacity, the details of each function
argument and expected output. This was done by providing supplemental figures and equations,
all saved as bitmap images (.bmp), and linking them into the help file (.htm). These figures and
equations for the help file were edited in the HTML Help Image Editor. Sample HTML code for
the function that calculates averaged Nusselt number for flow over a flat plate is provided below
in Figure 13.

Figure 13 Sample HTML code for a help file
The major components of each file include the title and the body. The body contains the
function call and arguments, detailed descriptions with unlimited character space, links to
images, and a citation for the supplemental text that a user should refer to for additional
information. The highlighted line is the link to the bitmap image named
Laminartoturbulent.bmp. The corresponding HTML code for linking that image to the help file
is
<img src=Laminartoturbulent.bmp>.
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In order for the image to properly link to the appropriate help file, the image must be saved in the
same folder as the corresponding help file. Proper care was taken to give credit to all scanned
images and figures as well as equations for the Heat Transfer help files5. The Table of Contents
and Index files allowed for organization and clustering of the whole help module. The compiled
help file view can be seen in Figure 14.

Figure 14 Compiled help file view
Several internet sites provide assistance on HTML code for beginners. In particular, Alan
Wood’s website provides lots of pertinent information on HTML code for symbol font of Greek
and special characters6. These are especially useful for writing help for equations in the Help
Workshop.
The compiled help files (.chm) files can be downloaded off the internet also at the project
website and placed in the same folder with the add-in. Once downloaded, the user needs to visit
the Properties of the file to “Unblock” the Security prevention mechanism as seen at the bottom
of Figure 15. Then the user will be able to view the help file via “Help on this function” as long
as the Add-In(.xlam) and the help file(.chm) are in the same folder.
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Figure 15 Compiled help file security block/unblock

Writing Help Files for Energy Systems Design
The method for writing the Energy Systems Design help file followed the exam same pattern
mentioned above for the Heat Transfer help file. Though there were only eight help files to
write, as opposed to nineteen for Heat Transfer, some of the help files involved very thorough
explanation. The details of the operation of these functions were described to the best capacity
and should supplement students looking for explanation to go along with the text.
Several of the user-defined functions for Energy Systems Design involve array outputs.
Supplemental figures and equations were once again provided to assist in explanation of these
functions. The HTML Help Image Editor supported the considerable number of figures that
became part of the help files. A sample help file for the, Vis_pump_QHE, viscous pump flow,
head, and efficiency matrix describes a function that outputs an array and is presented below in
Figure 16.
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Figure 16 Sample help file for Vis_pump_QHE
The help file pictured shows some of the body. The table presented is a bitmap image used to
describe how corrected pump curve data will appear. Once again, in order for the image to
properly link to the appropriate help file, the image must be saved in the same folder as the
corresponding help file. Proper care was taken to give credit to all scanned images and figures as
well as equations for the Energy Systems Design help files7. The Table of Contents and Index
files allowed for organization and clustering of the whole help module. The compiled help file
view can be seen in Figure 17.
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Figure 17 Compiled help file view
This compiled help file(.chm) can also be downloaded off the internet at the project website and
placed in the same folder with the add-in. Once downloaded, the user needs to visit the
Properties of the file to “Unblock” the Security prevention mechanism. The user will be able to
view the help file via “Help on this function” as long as the Add-In(.xlam) and the help
file(.chm) are in the same folder.
Example
Problem
An aluminum pin fin 15 mm in length and 5 mm in diameter is integrally attached to a wall
which is maintained at 100 C. Air at 20C flows past the pin at 5 m/s. What is the heat transfer
coefficient and the heat loss from the fin?

The help description and detailed help for the pin fin are seen in Figures 20 and 21. The HTML
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Solution
The problem requires use of a correlation to estimate the heat transfer coefficient. The “Heat
Transfer” module function help presents a list of available functions, as seen in Figure 18. The
NuDBarCyl help description indicates this is the proper function for flow over a cylinder. By
clicking on “Help on this function”, the HTML help file for the function is presented as seen in
Figure 19. This help screen confirms that the properties are needed at the film temperature for
the flow, so this is the temperature needed to compute the fluid properties.

Figure 18. List of available functions for the heat transfer module.
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Figure 19. HTML help for the NuDBarCyl function.

Figure 20. Help description for the fin efficiency function
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Figure 21. HTML help on the round pin fin efficiency function

help gives the definitions of the “m” and “Lc” parameters for the fin and these are incorporated
into the spreadsheet.
The complete spreadsheet solution is seen in Figure 22 below.
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Figure 22. Screen shot of Excel solution for the example.

Conclusions
Through the discovery of the extensive capabilities of VBA in Microsoft Excel and the Microsoft
HTML Help Workshop, a valuable reorganized design of developed modules and additional
“user help” was created to assist students in the use of Excel for spreadsheet-based solution
techniques in the thermal mechanical engineering curriculum. Both relatively straightforward in
nature, the Microsoft HTML Help Workshop and VBA in Microsoft Excel demonstrate excellent
potential for creation of modules to assist in teaching and learning of thermal mechanical
engineering concepts. Excel makes documentation of the solution neat and efficient and at the
same time allows for review or reference in the future. The compiled help files created in the
HTML Help Workshop compliment the modules by providing assistance to the user in areas
where he or she lacks knowledge of a certain subject or the operation of user-defined functions.
The compiled help files can also be valuable in the future for review or reference of material that
has not been studied recently. The ease-of-use and ready availability of both pieces of software
are essential to integration of Excel in the classroom. In engineering studies, uniform
organization and consistent usage of software in the classroom and at home establishes practical
techniques for problem solving.
Acknowledgement
This material is based upon work supported by the National Science Foundation
under Grant No. DUE-0633330. The authors gratefully acknowledge support from
this NSF award.

Disclaimer
Any opinions, findings, and conclusions or recommendations expressed in this material are those
of the author(s) and do not necessarily reflect the views of the National Science Foundation.
Bibliography
1. Huguet, Jesse and Keith Woodbury. Development of Steam and Ideal Gas Property Functions for Use in
Thermodynamics Curriculum, Proceedings of the 2008 ASEE Annual Conference & Exposition. June
2008, Pittsburgh, PA.
2. Woodbury, K. A., Taylor, R. P., Huguet, J., Chappell, J., Dent, T., and Mahan, K., “Vertical Integration of
Thermal Mechanical Curriculum using Excel,” ASME International Mechanical Engineering Congress and
Exposition, October 31 – November 6, 2008, Boston, MA
3. Excel in M.E. Project Website.2009. University of Alabama. January 23 2009 from:
<http://www.me.ua.edu/excel>.
4. Microsoft Developer Network. 2009. Microsoft HTML Help 1.4 SDK. January 23, 2009, from
<http://msdn.microsoft.com/en-us/library/ms670169.aspx>.
5. Incropera, F.P., DeWitt,D.P., Bergman, T.L., & Lavine,A.S. 2007. Introduction to Heat Transfer Fifth Edition.
Hoboken: John Wiley & Sons, 2007.
6. Wood, A. 2009. January 23, 2009, from Alan Wood’s Web Site:
<http://www.alanwood.net/demos/symbol.html>.

Page 14.601.21

7. Hodge, B.K., & Taylor, R. 1990. Analysis and Design of Energy Systems, Third Edition. New Jersey: Prentice
Hall.

